Virex®
version 7.6

McAfee®
System Protection
Industry-leading intrusion prevention solutions
Contents

1 Introducing Virex 7.6 5
What's in this guide? ................................................................. 5
What is Virex 7.6? ................................................................. 5
How does Virex 7.6 work? .................................................... 6
What you can do with Virex 7.6 ............................................. 6
What's new in this release ..................................................... 7
Virex 7.6 features ................................................................. 7
  Virex 7.6 Console ............................................................... 8
  Active Scanner ................................................................. 9
  Background Scanner ......................................................... 9
  Mounted Volumes Scanner .................................................. 9
  On-Demand Scanner ......................................................... 10
  Uvscan Command-line Scanner ........................................... 10
  Core Scanner ................................................................. 10
  HealthCheck ................................................................. 10
  VirexReport ............................................................... 11
  Virex Schedule Editor ..................................................... 11
  eUpdate ................................................................. 11
Audience ................................................................. 11
Conventions ................................................................. 12
Resources ................................................................. 13
  Getting product information ............................................. 13
  Links from within the product ......................................... 14
  Product services .......................................................... 15
  Contact information ..................................................... 16

2 Installing Virex 7.6 19
System requirements ......................................................... 19
  ePolicy Orchestrator requirements ..................................... 20
Installing Virex ................................................................. 20
Upgrade Installation ......................................................... 21
Testing your installation ................................................... 22
Uninstalling Virex ............................................................. 22

3 Getting Started 25
Using the Virex 7.6 Console ................................................ 25
  The Virex Console ........................................................ 25
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool bar</td>
<td>26</td>
</tr>
<tr>
<td>Menu bar</td>
<td>27</td>
</tr>
<tr>
<td>Configuring the Scanners</td>
<td>27</td>
</tr>
<tr>
<td>Creating an exclusion list</td>
<td>29</td>
</tr>
<tr>
<td>Using the On-Demand Scanner</td>
<td>30</td>
</tr>
<tr>
<td>Updating virus definitions (DAT files)</td>
<td>30</td>
</tr>
<tr>
<td>Using the Virex Schedule Editor</td>
<td>31</td>
</tr>
<tr>
<td>Scheduling Scans</td>
<td>31</td>
</tr>
<tr>
<td>Scheduling eUpdates</td>
<td>33</td>
</tr>
<tr>
<td>Using VirexReporter</td>
<td>35</td>
</tr>
<tr>
<td>4 Troubleshooting</td>
<td>37</td>
</tr>
<tr>
<td>Frequently asked questions</td>
<td>37</td>
</tr>
<tr>
<td>Installation</td>
<td>37</td>
</tr>
<tr>
<td>Scanning</td>
<td>38</td>
</tr>
<tr>
<td>Viruses and detection</td>
<td>38</td>
</tr>
<tr>
<td>General information</td>
<td>39</td>
</tr>
<tr>
<td>Advanced troubleshooting</td>
<td>40</td>
</tr>
<tr>
<td>Error messages</td>
<td>41</td>
</tr>
<tr>
<td>Error messages - Virex application</td>
<td>41</td>
</tr>
<tr>
<td>Error messages - virex.log</td>
<td>42</td>
</tr>
<tr>
<td>Glossary</td>
<td>43</td>
</tr>
<tr>
<td>Index</td>
<td>47</td>
</tr>
</tbody>
</table>
1

Introducing Virex 7.6

What’s in this guide?

This guide introduces McAfee® Virex® software version 7.6, and provides the following information on how to keep your computer free of viruses.

- Overview of the product.
- Descriptions of product features.
- Descriptions of all new features in this release of the software.
- Detailed instructions for installing the software.
- Detailed instructions for configuring and deploying the software.
- Procedures for performing tasks.
- Troubleshooting information.

What is Virex 7.6?

Virex 7.6 is an anti-virus application that helps you keep your Apple computer free of viruses, Trojan horses and other malicious code. It scans volumes, files, and folders and provides detailed reports of what it finds. Virex 7.6 features on-demand scanning, scan and update scheduling, online help and “drag and drop” scanning. In addition, you are only one click away from the comprehensive online Virus Information Library which will keep you informed of all new threats. The Virex 7.6 design is based on Cocoa, the specialized Mac OS X application environment.
How does Virex 7.6 work?

Virex protects your system from viruses that may reside on other computers such as Macintosh computers, Windows computers, UNIX computers, and volumes such as USB devices and CDs. The Virex Active Scanner, Background Scanner, and Mounted Volumes Scanner are background processes that continuously check your system, its files, CDs, and USB devices for possible viruses and other harmful programs.

What you can do with Virex 7.6

The Virex 7.6 anti-virus scanners give you powerful features that you can customize to meet your needs:

- Virex detects and cleans program viruses, macro viruses, and Trojan horses for all types of Macintosh, Windows, and UNIX files, including compressed files and OLE compound documents.

- With Virex 7.6, you can scan a single file, a file directory, your whole drive, or mounted volumes such as CDs, .DMG files, and USB devices such as pen drives and cameras.

- Advanced heuristic scanning detects previously unknown macro and program viruses.

- The HealthCheck component monitors anti-virus scanners to ensure they do not quit, and restarts them if they do, to ensure that you are always protected.

- You can perform On-Demand scanning and automate scheduled scans.

- Scheduled and automated updates ensure that your anti-virus protection is kept up-to-date, guarding against viruses and other threats as they emerge.
What’s new in this release

Virex 7.6 includes ePolicy Orchestrator manageability.

**Previous release**
Virex 7.5.1 did not have ePolicy Orchestrator manageability feature.

**Current release**
This release integrates Virex 7.6 with ePolicy Orchestrator 3.02 and above providing you with a single point of control for your systems running Virex 7.6 software.

**Benefits**
The ePolicy Orchestrator software provides a central hub of McAfee System Protection Solutions, administrators can mitigate the risk of rogue, non-compliant systems, keep protection up-to-date, configure and enforce protection policies, and monitor security status from one centralized, enterprise-scalable console. Using ePolicy Orchestrator, you can configure Virex on the target systems across your network; you do not need to configure them individually from the Virex Preferences window.

**For more information**
See ePolicy Orchestrator Product Guide, Virex 7.6 Configuration Guide (for use with ePolicy Orchestrator) and Non Windows Agent ReadMe.

*. Non Windows Agent (NWA) is also known as ePolicy Orchestrator Agent for Mac OS X.

You will be able to use ePolicy Orchestrator related functionality only if you have ePolicy Orchestrator server installed and configured to manage Virex 7.6. The use of ePolicy Orchestrator is optional and you can use all the functionality of Virex 7.6 as a standalone product.

Virex 7.6 features

Virex 7.6 incorporates its previous powerful features with new safeguards and tools for you to protect your computer system. For more information on new features, please see Getting Started on page 25. The online help system provides you with troubleshooting assistance and procedures for tasks.
The following image map diagrams show the common dialog boxes you will encounter while using Virex.

### Virex 7.6 Console

The Virex 7.6 console enables the configuration of Virex through an easy-to-use interface. In earlier versions of Virex, the console featured limited functionality.
Through the updated console, you can schedule tasks, configure the Active Scanner, Background Scanner, Mounted Volumes Scanner, and On-demand Scanner as well as perform On-demand scans through the drop-zone (an area on the Virex console that allows you to drag and drop files that you want to scan) and a file open dialog box. The console is also used to start eUpdates. To access the Virex console, double-click on the Virex 7.6 shield icon inside your computer’s Applications folder.

**Active Scanner**

The Active Scanner provides continuous anti-virus protection on the hard disk from network connections and the Internet. As the Active Scanner is continuously working on your computer, your system will not be exposed to the risk of infection.

The Active Scanner scans files when they are written to your hard drive (all partitions) and all removable drives. It starts when your computer starts and runs until the computer is shut down; the scanner is running on your computer by default. You can configure what the scanner looks for and how it will respond to infected files. Preferences for Active Scanner are found under Preferences on the Virex 7.6 menu.

**Background Scanner**

The Background Scanner permanently scans all files on your system. The scanner protects your computer by continuously searching your system for infected files.

This scan is a low-resource operation so there is no performance decrease to your computer. You can configure what the scanner looks for and how it responds to infected files. Preferences for the scanner are found under Preferences on the Virex 7.6 menu.

**Mounted Volumes Scanner**

The Mounted Volumes Scanner initiates a scan of a volume such as a CD or camera when one is locally mounted. With this scanner you can scan a large volume or device for infection before interfacing it with your system. This limits your system’s exposure to malicious viruses.

This feature only works with locally inserted or ejectable media, such as Zip drives, CD, DVD, or OS X .DMG files. It also scans USB card devices such as pen drives and cameras, and Firewire devices such as iPod. It does not scan volumes on remote machines connected through the network. The scanner operates in the background and interacts with the user. The Mounted Volumes Scanner is not running on your computer by default. To turn this scanner on, use the Preferences option on the Virex 7.6 menu.
On-Demand Scanner
The On-Demand Scanner allows you to initiate a scan at any time by dragging and dropping selected files into the console or through a file open dialog box.

With the On-Demand Scanner you can select multiple files, directories, or volumes. Scan results are summarized in a report that can be saved or printed. You can configure what the scanner looks for and how it responds to infected files. You can also configure an exclusion list that is shared with the Active Scanner, Background Scanner and Mounted Volumes Scanner. The scanner notifies you when it finds a virus and generates a log that appends its actions. To access the On-Demand Scanner, drag the file(s) you want to scan and drop them into the Virex shield icon or into the Drop Zone in the Virex console.

Uvscan Command-line Scanner
The Uvscan Command-line Scanner is a stand-alone on-demand scanner for OS X environments. It allows advanced users to access the same on-demand scanner functionality as the Virex 7.6 Console, but from a terminal shell. As the functionality is the same, this guide does not include information on how to use Uvscan. Some help is available from its man pages. You can access the Uvscan Command-line scanner at /usr/local/vscanx.

Core Scanner
The Core Scanner utilizes the latest virus-scanning engine to provide functionality for the Active Scanner, the Background Scanner, and the Mounted Volumes Scanner. This scanner provides queuing for scan tasks and powerful scanning tools to operate the individual scanners. The Core Scanner is running by default.

HealthCheck
HealthCheck ensures your system is protected and any outage is minimized by monitoring the operation of all other scanners and restarting them if they fail.

HealthCheck monitors the Active Scanner, Background Scanner, Mounted Volumes Scanner, Core Scanner, and eUpdate components. It keeps track of current preferences and the exclusion list and continues them when restarting a scanner. If any of the components have quit, HealthCheck restarts the scanner without any user intervention. HealthCheck has no user interface; it is an internal component to the anti-virus system.
VirexReporter

The VirexReporter reports infected files found by scanners. The VirexReporter provides tracking and reporting to the anti-virus scanning so you can see where threats to your system may be coming from.

VirexReporter automatically launches when an infected file is found. When an infection is found by the Core Scanner, a window appears with a list of the items found by the Core Scanner and the action taken.

Virex Schedule Editor

The Virex Schedule Editor enables you to schedule automated scans and updates to virus definition (DAT) files and software components that are available online.

You can schedule scans and updates through the Virex Schedule Editor on the console. Automated scans and updates can be set on a daily, weekly, or monthly basis. To access the Schedule Editor, select Scheduled Task under View in the Virex console menu.

eUpdate

eUpdate allows you to update DAT files and the virus-scanning engine. eUpdate keeps your anti-virus software continuously updated with new information on viruses and scanning capabilities.

eUpdate automatically checks for new updates when there is an Internet connection and launches the console when one is available. You can configure eUpdate to check for updates on your own schedule through the Virex Schedule Editor. To initiate an eUpdate, click on the eUpdate tab on the console and then the Start button. This support is provided through HTTP or FTP.

Audience

This information is intended for network administrators who are responsible for their company’s anti-virus and security program.
Conventions

This guide uses the following conventions:

**Bold Serif**
All words from the user interface, including options, menus, buttons, and dialog box names.

Example:
Type the **User** name and **Password** of the desired account.

**Courier**
The path of a folder or program; a web address (URL); text that represents something the user types exactly (for example, a command at the system prompt).

Examples:
The default location for the program is:
C:\Program Files\McAfee\EPO\3.5.0
Visit the McAfee web site at:
http://www.mcafee.com
Run this command on the client computer:
C:\SETUP.EXE

**Italic**
For emphasis or when introducing a new term; for names of product documentation and topics (headings) within the material.

Example:
Refer to the *VirusScan Enterprise Product Guide* for more information.

**<TERM>**
Angle brackets enclose a generic term.

Example:
In the console tree under **ePolicy Orchestrator**, right-click **<SERVER>**.

**Note:** Supplemental information; for example, an alternate method of executing the same command.

**Tip:** Suggestions for best practices and recommendations from McAfee for threat prevention, performance and efficiency.

**Caution:** Important advice to protect your computer system, enterprise, software installation, or data.

**Warning:** Important advice to protect a user from bodily harm when interacting with a hardware product.

**New:** New or redesigned feature or option of this release of the product.
Resources

McAfee® products denote years of experience, and commitment to customer satisfaction. The McAfee PrimeSupport® team of responsive, highly skilled support technicians provides tailored solutions, delivering detailed technical assistance in managing the success of mission critical projects — all with service levels to meet the needs of every customer organization. McAfee Research, a world leader in information systems and security research, continues to spearhead innovation in the development and refinement of all our technologies.

Refer to these sections for additional resources:

- Getting product information
- Links from within the product
- Product services
- Contact information

Getting product information

Unless otherwise noted, the product documentation is provided as Adobe Acrobat .PDF files available on the product CD or from the McAfee download site

**Product Guide** — Product introduction and features, detailed instructions for configuring the software, information on deployment, recurring tasks, and operating procedures.

- **Virex 7.6 Product Guide**

**Help** — High-level and detailed information accessed from the software application: Help menu and/or Help button for page-level help; right-click option for *What’s This?* help.

**Configuration Guide** — For use with *ePolicy Orchestrator®*. See Virex Configuration guide (for use with *ePolicy Orchestrator*). This guide is available in the ePolicy Orchestrator Server package. This guide introduces ePolicy Orchestrator manageability features for Virex, and provides detailed instructions for installing, configuring and managing Virex in an enterprise environment.

**Non Windows Agent**ⁱ ReadMe** — See Non Windows Agent ReadMe file for Macintosh. This ReadMe describes the agent features, lists any known behavior or other issues with the product release, and describes the ePolicy Orchestrator Agent installation process.

¹ Non Windows Agent is also known as ePolicy Orchestrator Agent.
Introducing Virex 7.6

Resources

**Release Notes**^ — *ReadMe.* Product information, resolved issues, any known issues, and last-minute additions or changes to the product or its documentation.

**Contacts**^ — Contact information for McAfee services and resources: technical support, customer service, Security Headquarters (AVERT Anti-Virus & Vulnerability Emergency Response Team), beta program, and training. This file also includes phone numbers, street addresses, web addresses, and fax numbers for company offices in the United States and around the world.

**License** — The McAfee License Agreement booklet that includes all of the license types you can purchase for your product. The License Agreement sets forth general terms and conditions for the use of the licensed product.

* A printed manual that accompanies the product CD. Note: Some language manuals may be available only as a .PDF file.
^ Text files included with the software application and on the product CD.
** You will be able to use ePolicy Orchestrator related functionality only if you have ePolicy Orchestrator server installed and configured to manage Virex 7.6. The use of ePolicy Orchestrator is optional. You can use all the functionality of Virex 7.6 as a standalone product.

**Links from within the product**

The **Help** menu in the product provides links to some useful resources:

- Online help
- Virus Information Library
- ReadMe
- Product Guide
- License

**Online Help**

Use this link to access the online Help topics for the product.

---

If the product’s built-in help system (accessed from within the software by clicking the **Help** menu) displays incorrectly on your system, your version of Microsoft® Internet Explorer may not be using ActiveX controls properly. These controls are required to display the help file. Make sure that you install the latest version of Internet Explorer.
**Virus Information Library**
Use the Virus Information link to access the McAfee Anti-Virus & Vulnerability Emergency Response Team (AVERT) Virus Information Library. This web site has detailed information on where viruses come from, how they infect your system, and how to remove them.

In addition to genuine viruses, the Virus Information Library contains useful information on virus hoaxes, such as those virus warning that you receive via e-mail. A Virtual Card For You and SULFNBK are two of the best-known hoaxes, but there are many others. Next time you receive a well-meaning virus warning, view our hoax page before you pass the message on to your friends.

**To access the Virus Information Library:**
1. Open the Virex product interface.
2. Select Virus Information Library from the Help menu.

**ReadMe**
Use the ReadMe link to access the ReadMe file of Virex 7.6.

**Product Guide**
Use the Product Guide link to access the Virex 7.6 Product Guide in PDF (Portable Document Format).

**License**
Use the License link to access the McAfee Software License Agreement.

**Product services**
The following services are available to help you get the most from your McAfee products:

- Beta program
- HotFixes and Patches
- Product “end-of-life” support

**Beta program**
The McAfee beta program enables you to try our products before full release to the public — you can learn about and test new features for existing products, as well as try out entirely new products. This program can help you test and implement updated and new features earlier, and in a safe environment. You get the chance to suggest new product features, as well as deal directly with McAfee engineering staff.
To find out more, visit:


**HotFixes and Patches**
HotFixes and Patches are released with updated files, drivers, executables, etc., between the major releases of a product. To access the latest HotFixes and Patches, visit:


**Product “end-of-life” support**
Your anti-virus software must be kept up-to-date to remain effective against viruses and other potentially harmful software. It is important to update the virus definition (DAT) files regularly. To enable the software to counter the continuing threat, we often make architectural changes to the way that the DAT files and virus-scanning engine work together. It is therefore important that you update your engine when a new version is released. An older engine will not catch many of the new emerging threats.

When we release a new engine, we announce the date after which the existing engine will no longer be supported. For information on our product “end-of-life” policy and for a full list of supported engines and products, visit:


**Contact information**

**Technical Support**

Home Page http://www.mcafeesecurity.com/us/support/technical_support
KnowledgeBase Search https://knowledgemap.nai.com/phpclient/homepage.aspx
PrimeSupport Service Portal * https://mysupport.nai.com

**McAfee Beta Program**


**Security Headquarters — AVERT: Anti-virus & Vulnerability Emergency Response Team**

Virus Information Library http://vil.nai.com
AVERT WebImmune, * https://www.webimmune.net/default.asp
Submitting a Sample
Download Site

Home Page

DAT File and Engine Updates

Product Upgrades *

Training

On-Site Training

McAfee University

Customer Service

E-mail
https://secure.nai.com/us/forms/support/request_form.asp

Web

US, Canada, and Latin America
toll-free: +1-888-VIRUS NO or +1-888-847-8766
Monday – Friday, 8 a.m. – 8 p.m., Central Time

For additional information on contacting McAfee — including toll-free numbers for other geographic areas — see the Contact file that accompanies this product release.

* Logon credentials required.
Installing Virex 7.6

This chapter provides you with information you require to install Virex 7.6 software. This chapter also provides information on:

- System requirements for Virex.
- ePolicy Orchestrator requirements for Virex.
- Installing Virex.
- How to test if your Virex installation is working properly.
- How to uninstall Virex.

System requirements

Virex installs and runs on any Apple computer that meets these requirements:

- Apple Macintosh OS X (10.2.6 or later) operating system.
- 266 MHZ Power PC G3 (or later) with 128 MB RAM.
- 40 MB of free disk space.
- Virex 7.6 requires the BSD subsystem to be installed in order to function correctly. The BSD subsystem is installed by default as part of Mac OS X, but you can choose not to install it. If you have installed Mac OS X without the BSD subsystem, insert the Mac OS X CD and install the BSD subsystem before continuing.

This product does not use Classic. The Virex 7.6 Installer installs the Virex 7.6 software in the Applications folder of your computer. For Virex known issues, refer to the ReadMe in the Help menu.

The operating system must be installed and running correctly before you install the Virex software.
ePolicy Orchestrator requirements

Virex 7.6 integrates with ePolicy Orchestrator version 3.02 or later.

You will be able to use ePolicy Orchestrator related functionality only if you have ePolicy Orchestrator server installed and configured to manage Virex 7.6. The use of ePolicy Orchestrator is optional and you can use all the functionality of Virex 7.6 as a standalone product.

Installing Virex

The procedures for installing Virex on Mac OS 10.2.X Jaguar differ from installation on Mac OS 10.3.X Panther.

To install Virex on Mac OS 10.2.X Jaguar:

1. Double-click the Virex package icon to start the Installer.

2. Type your user name and system password in the Authentication dialog box. You will need administrative privileges to install. Click OK.

3. The Virex Installer window appears.

4. Follow the on-screen steps to install the software.

5. Read and accept the license agreement. If you do not accept the license agreement, the installation cannot continue.

6. Click Install to perform an Easy Install.

7. When the Installer finishes it notifies you with a dialog box. Restart your computer after installing Virex. This will ensure that all of the scanners start properly.

To install Virex on Mac OS 10.3.X Panther:

1. Double-click the Virex package icon to start the Installer.

2. Follow the on-screen steps to install the software.

3. Read and accept the license agreement. If you do not accept the license agreement, the installation cannot continue.

4. Click Install to perform an Easy Install.

5. The Authentication dialog box appears.
6 Type your user name and system password. You will need administrative privileges to complete the installation. Click OK.

7 When the Installer finishes it notifies you with a dialog box. Restart your computer after installing Virex. This will ensure that all of the scanners start properly.

Virex 7.6 is now located in your computer’s applications folder. The ReadMe file is included in the Help menu. Refer to this file for known issues, online resources, and other useful information.

By default, the Active Scanner is on while the Background and Mounted Scanners are off. You need to manually configure scanners for functions like checking files for virus-like characteristics. See Configuring the Scanners on page 27.

With Virex 7.6 you use the eUpdate feature to connect to a Web location and download new DAT files. To find out more about eUpdate and other Virex features, see Getting Started.

Upgrade Installation

1 Double-click the Virex package icon to start the Installer. Follow the on-screen steps to install the software.

2 Read and accept the license agreement. If you do not accept the license agreement, the installation cannot continue.

3 Select the destination volume to install Virex 7.6 software and click Continue. The Easy Install window appears.

![Figure 2-1 Easy Install - Upgrade window](image)

Figure 2-1 Easy Install - Upgrade window
4. Click **Upgrade** to reinstall or upgrade Virex.

5. The **Authentication** dialog box appears.

6. Type your user name and system password. You will need administrative privileges to complete the installation. Click **OK**.

7. When the Installer finishes installing the package it notifies you with a dialog box. Restart your computer after installing Virex. This ensures that all of the scanners start properly.

### Testing your installation

You can test Virex by using the EICAR Standard Anti-Virus Test File. This file is a combined effort by anti-virus vendors throughout the world to implement one standard by which customers can verify their anti-virus software.

**To test your installation:**

1. Go to the EICAR web site (http://www.eicar.org). Click **AntiVirus testfile EICAR.COM** on the left side of the screen.

2. Scroll down the page to the download area. Obtain the EICAR test file by clicking **eicar.com**. When Virex scans this file, it will report finding the test file.

   This file is not a virus. Delete the file when you have finished testing to avoid alarming unsuspecting users.

If the test is successful, you are now ready to start using the Virex software. The online help system that is part of the application tells you how to scan and clean files, folders and so on, update the “Virus definition (DAT) files” and get report information. To get online help, either select **Virex Help** from the **Help** menu or search the Mac Help Center.

### Uninstalling Virex

You can uninstall Virex 7.6 by using the uninstall command on your installation CD.

**To uninstall Virex:**

1. Open the Virex 7.6 CD and choose one of the following options:
- Click **Virex Uninstall.command** icon.
- Drag **Virex Uninstall.command** icon and drop it in the Terminal window.

The Terminal window prompts you for the system password.

2. Type your system password.

![Your system password will not be displayed in the Terminal window.](image)

3. Enter.

4. When the uninstall command completes, the **Terminal** window shows:

```
Last login: Mon Feb 20 06:24:45 on console
Welcome to Darwin!
$ cd /Volumes/Virex/7.6/Virex Uninstall
$ ./Virex Uninstall

This will uninstall Virex 7.6. If you wish to proceed, authenticate below or close this window
if you wish to cancel.
sudo timestamp too far in the future: Jan 1 00:00:00 1905

We trust you have received the usual lecture from the local System Administrator. It usually boils down to these two things:

1) Respect the privacy of others.
2) Think twice before you type.

Password:

Uninstalling Virex 7.6...
Shutting down Virex Daemon...
Removing Virex Application Folders...
Removing Virex Support Files...
Removing Virex Engine...
Removing Virex Support Documentation...
Cleaning up...
Logoff
[Process completed]
```

![Figure 2-2 Terminal window](image)
Getting Started

This chapter introduces Virex 7.6, how it helps keep your computer free of viruses and includes the following topics:

- **Using the Virex 7.6 Console**
- **Configuring the Scanners**
- **Using the On-Demand Scanner**
- **Updating virus definitions (DAT files)**
- **Using the Virex Schedule Editor**
- **Using VirexReporter**

### Using the Virex 7.6 Console

The Virex console allows you to use and configure on-demand scanning and set scanning preferences for Active Scanning, Background Scanning, and Mounted Volumes Scanning. The console connects you to the McAFee Virus Information Library, performs eUpdates, and prints and saves virus scan reports. The Virex console also contains a drag-and-drop pane for on-demand scanning and a report panel showing current scan reports.

With the drag-and-drop feature, you can initiate a scan at any time by dragging the file(s) into the center pane of the console. When you drop a file into the drag-and-drop pane, click on the **Start** button to initiate a scan. If you add another file after the scan has completed, the new file will replace the first scan.

### The Virex Console

The Virex console displays standard Macintosh and specialized anti-virus components, including:
- Title bar displaying the name of the program that is currently running.
- Close, minimize, maximize, and hide tool bar buttons to resize or hide the interface.

![Figure 3-1 The Virex console](image)

**Tool bar**

The tool bar displays these buttons:

- ![Save icon](image) Saves the virus scan report as a Rich Text File (.RTF).
- ![Clear icon](image) Clears the current report showing on the status panel.
- ![Print icon](image) Prints the current report.
- ![Preferences icon](image) Opens the Preferences dialog box, allowing you to:
  - Set preferences for the Active Scanner, Background Scanner, On-Demand Scanner, and Mounted Volumes Scanner.
  - Toggle Active, Background, and Mounted Volumes Scanners.
  - Set preferences for the action to take if a virus is found.
  - Log results to a file.
  - Configure eUpdate Server Settings.
  - Create an exclusion list.
  - Automate virus definitions updates and virus scans.
- ![Info icon](image) Opens your default browser and directs you to the McAfee Virus Information Library.
Menu bar
The menu bar shows these standard drop-down menus common to all screens: File, Edit, View, Window, and Help.

Configuring the Scanners

The Active Scanner is on by default while the Background Scanner and Mounted Volumes Scanner are both off by default. Preferences are saved immediately when you select them.

To configure the Active Scanner, Background Scanner, Mounted Volumes Scanner, and On-Demand Scanner:

1. Click Preferences on the tool bar.

2. The Preferences dialog box appears.

3. Click More Options in the lower right-hand corner of the dialog box to reveal Advanced Preferences.

4. Select the scanner you want to configure from the center drop-down menu.

Figure 3-2  The Preferences dialog box

4. Select the scanner you want to configure from the center drop-down menu.
5  Select your scanning preferences:

**Table 3-1 Preferences**

<table>
<thead>
<tr>
<th>Simple Preferences</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically check for virus definition updates</td>
<td>Enables / disables automatic eUpdates.</td>
</tr>
<tr>
<td>Scan local volumes when mounted</td>
<td>Enables / disables the Mounted Volumes Scanner scanner.</td>
</tr>
<tr>
<td>Background virus detection</td>
<td>Enables / disables the Background Scanner.</td>
</tr>
<tr>
<td>Active virus detection</td>
<td>Enables / disables the Active Scanner.</td>
</tr>
<tr>
<td>When a virus is found:</td>
<td>Selects the primary action of the four scanners. This selection will be unavailable if one of the scanners is configured differently from the others.</td>
</tr>
<tr>
<td>▪ Clean</td>
<td></td>
</tr>
<tr>
<td>▪ Delete</td>
<td></td>
</tr>
<tr>
<td>▪ Notify</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings for Advanced Global Preferences</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Log results to file</td>
<td>Enables / disables logging results to a file.</td>
</tr>
<tr>
<td>Customize eUpdate Server Settings</td>
<td>Manages your update server with user name and password.</td>
</tr>
<tr>
<td>Customize...</td>
<td>Displays a dialog box for you to customize the HTTP or FTP settings for eUpdate.</td>
</tr>
<tr>
<td>Exclude specific disks, files and folders</td>
<td>Configures your scanning exclusions. The exclusions are stored as a list in a text file called VShieldExclude.txt. If this is not selected then you will not have any exclusions set.</td>
</tr>
<tr>
<td>Exclusions…</td>
<td>Opens the exclusion file in TextEdit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Advanced Preference Settings for each scanner</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan contents of archives and compressed files</td>
<td>Sets the selected scanner to scan into archives and other compressed files. On by default for Background and On-Demand Scanners.</td>
</tr>
<tr>
<td>Remove macros from potentially infected files</td>
<td>If an infected file is detected then all macros from that file will be removed as part of the clean.</td>
</tr>
<tr>
<td>Check files for virus-like characteristics</td>
<td>Enables / disables heuristics, which scans for files that show characteristics of viruses or worms and may contain unknown infections. On by default for Background Scanner.</td>
</tr>
<tr>
<td>Find potentially unwanted applications and joke programs</td>
<td>Enables / disables the scanner to check for unwanted programs or joke programs.</td>
</tr>
<tr>
<td>Delete when Clean fails or is not available</td>
<td>Selects the secondary action for the selected scanner. This is only available when the primary action is Clean.</td>
</tr>
</tbody>
</table>

6  Click **Lock to prevent changes** to the preferences.
7 Click Close in the upper left-hand corner.

Scanner preferences are global settings that apply to all users.

The table below illustrates the preferences you would select to ensure protection for the common tasks.

<table>
<thead>
<tr>
<th>Common Tasks and Preferences</th>
<th>Select in Simple Preferences:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanning CD files before opening them</td>
<td>Scan local volumes when mounted</td>
</tr>
<tr>
<td>Detecting viruses when downloading files from the Internet to the hard drive</td>
<td>Active virus detection</td>
</tr>
<tr>
<td></td>
<td>Select in Active Scanner Preferences:</td>
</tr>
<tr>
<td></td>
<td>Check files for virus-like characteristics</td>
</tr>
<tr>
<td></td>
<td>Find potentially unwanted applications and joke programs</td>
</tr>
<tr>
<td></td>
<td>Scan contents of archives and compressed files</td>
</tr>
</tbody>
</table>

Creating an exclusion list

The user-configurable exclusion list prevents the scanners from scanning specific files, directories, or volumes. The exclusion list is shared with the Active Scanner, Background Scanner and the Mounted Volumes Scanner.

To create an exclusion list:
1 Click Preferences on the tool bar. The Preferences dialog box appears.
2 Click More Options in the lower right-hand corner of the dialog box.
3 Click Exclude specific disks, files and folders.
4 Click Exclusions. The VShieldExclude.txt file opens.
5 Type the full path name of each file, directory, and volume you want to exclude from the scan, for example:
   /Users/herb/Documents/Recipes/cookbook.doc
   /Users/herb/Documents/Music/
6 Close the Preferences dialog box.
Using the On-Demand Scanner

The On-Demand Scanner allows you to initiate a scan at any time in the following ways:

- By dragging and dropping file(s) into the Virex dock icon, the Virex icon in the Finder, or into the drag-and-drop pane in the console.
- Through the file open dialog box.

You can select multiple files, directories, or volumes and the results are summarized in the Virex Reporting Window.

To perform On-demand Scanning:
1. Open the Virex main console.
2. Drag and drop the file, folder, or volume you want to scan into the drag-and-drop pane of the main console. To select a group of files, do one of the following:
   - Hold down the Shift key while selecting the files you want.
   - Click the drag-and-drop pane. A file selection screen appears. Select the file, group of files, directory, or volume you want to scan, then click Select Location.
   - Drag the file, folder, or volume to the Virex dock icon in the Finder view.
3. Click Start on the console to initiate scanning.

The Status Line shows the name of the file being scanned and the status of the scan. The arrow beside the status line hides or reveals the Virex Reporting Window. The Virex Reporting Window is hidden by default.

A scan report appears in the Virex Reporting Window. The report notes the time of the scan, total files scanned, and the actions taken. The console shows the status of the scan in a line between the drag-and-drop pane and the report panel. The status panel shows Idle when it is not scanning.

Updating virus definitions (DAT files)

eUpdate automatically connects weekly by default to the eUpdate Server via your Internet connection, and checks for new “Virus definitions (DAT) files.” You can schedule additional eUpdates through the Virex Schedule Editor or you can manually initiate an eUpdate at any time.
Why do you need to update?

- New viruses and worms emerge frequently. McAfee regularly releases updated DAT files to ensure Virex can detect such viruses and worms.

- Virus-scanning engine upgrades are occasionally available. These enable Virex to employ the latest virus-detection techniques.

To ensure that you are protected against the latest threats, you should keep your anti-virus software up-to-date by updating the DAT files and engine regularly.

How does eUpdate work?

eUpdate enables you to obtain and apply new DAT files or upgrades to your anti-virus software while connected to the Internet. If an update exists, Virex will automatically attempt to download and install the update.

If you do not wish to install the update at this time, you may cancel the process by clicking the Cancel button. After canceling an eUpdate, the Virex Console will automatically switch to the eUpdate pane every time it launches to remind you to update. If a week lapses without updating, Virex will automatically download the update. This ensures your system is up-to-date at all times.

To initiate an unscheduled eUpdate:

1. Open the Virex console.

2. Click the eUpdate tab to switch to the eUpdate pane.

3. Click Start to check if new virus definitions are available for download.

Using the Virex Schedule Editor

The Virex Schedule Editor allows you to schedule on-demand scans and eUpdates.

Scheduling Scans

The Virex Schedule Editor allows you to create repetitive scans on a group of files or directories. You can schedule daily, weekly, and monthly scans.
To schedule a scan:

1. Select **Scheduled Task** from the **View** menu on the console. The **Virex Schedule Editor** appears.

2. Click **New Scan Task**.

   The **New Scan Task** dialog box appears.

3. Name the task. Use a name that describes the scan you are scheduling.

4. Use the **Set** button to specify the **Date & Time** of the scheduled scan. **UTC** is Universal Time Coordinated (Greenwich Mean Time).

5. Choose the items you want scanned. You can do this by:
   - Dragging and dropping items into the **Scan Items** pane.
   - Clicking on the **Scan Items** pane. A **Choose Item** dialog box appears. Click **Choose** when you have selected the file(s) to scan.
6 Select **Recurrence**. Choose **Daily**, **Weekly**, **Monthly**, or **Never**:

- **Daily**: Type the sequence of days that the scan will perform.
- **Weekly**: Select the day(s) of the week on which you want this to occur.
- **Monthly**: Select the day(s) of the month the scan will occur, and the sequence of months.
- **Never**: Select this option if you do not want the scan to reoccur.

7 Specify when the schedule should end, and click **OK**.

Your new scan task appears in a list of all scheduled scans and eUpdates in the Virex Schedule Editor. To enable or disable scheduled tasks, select the check box next to the task item.

If the computer is turned off during a scheduled task, Virex 7.6 will miss the task when the computer is turned back on.

---

**Scheduling eUpdates**

The Virex Schedule Editor allows you to schedule repetitive updates to your system’s virus definition (DAT) files and the virus-scanning engine. This support is provided through HTTP or FTP.

eUpdate is programmed to check for new updates on its own. However, you can schedule additional eUpdates or modify the existing schedule.

**To schedule an eUpdate:**

1 Select **Scheduled Task** from **View** on the console.

   The **Virex Schedule Editor** appears.

2 Click **New eUpdate Task**.
The New eUpdate Task window appears.

![Figure 3-5 The New eUpdate Task dialog box](image)

3 Click the lock in the lower left-hand corner of the pane so that you can modify the automatic eUpdating.

The Authentication dialog box appears.

4 Type an administrator user name and password. Click OK.

5 Name the task. Use a name that describes the scan you are scheduling.

6 Use the Set button to specify a Date & Time for the update to occur.

7 Select Recurrence. Choose Daily, Weekly, Monthly, or Never:
   - Daily: Type the sequence of days you want the eUpdate to connect.
   - Weekly: Select the day(s) of the week on which you want this to occur.
   - Monthly: Select the day(s) of the month you want the automatic update, and the sequence of months.
   - Never: Select this option if you do not want the scan to reoccur.

8 Select an end date.

9 Click the Lock to prevent changes to the schedule. Click OK.
Your new eUpdate task appears in a list of all scheduled scans and eUpdates in the Virex Schedule Editor. To enable or disable eUpdate tasks, select the check box next to the task item. eUpdate will automatically launch the console when an update is available.

All scheduled eUpdate tasks apply to all users in OS X. The eUpdate schedule includes a small period of randomization so that all Virex products do not update from the server at exactly the same time. Therefore, your eUpdates will occur at slightly different times, just before or after the time that you set.

Using VirexReporter

VirexReporter reports infected files. When the Core Scanner finds an infected file, the Virus Alert window appears with a list of the infected items and action taken.

Figure 3-6 The VirexReporter Virus Alert

To use the VirexReporter:

1 In the Virus Alert window, click the arrow beside Show Details.

The VirexReporter gives a list of infected items and the action taken by Virex.

2 Do one of the following:

- Select Move To Trash to move the infected file(s) to the trash.
- Select Clean to clear the file of the suspected virus.
- Select Ignore to leave the file as it is.
This chapter provides solutions to situations that you might encounter when installing or using Virex software.

The following topics are included:

- Frequently asked questions
- Error messages

## Frequently asked questions

### Installation

**Why is the installer not working?**
Check the platform you are trying to install Virex onto: it must be Mac OS X 10.2.6 or later. Another reason might be that an existing anti-virus program had been detected during installation, and must be removed for Virex to be installed successfully. Virex 7.6 requires the BSD subsystem to be installed in order to function correctly.

**I just installed Virex onto my computer. Why is the scanner not working?**
If the product does not appear to be scanning after installation, restart your computer to ensure that all scanners are performing.

**What Virex files are installed and where?**
Virex 7.6 is installed in /Applications, and Virex Schedule Editor is installed in /Applications/Utilities. Uvscan, VShield Status, DAT files, and daemons can be found at /usr/local/vscanx.
Scanning

**Does Virex automatically scan files once they are created?**
The Active Scanner will scan files as they are saved to the hard drive.

**Why has Virex skipped scanning certain files?**
Check to make sure they are not on the exclusion list. Virex will also not scan archives and compressed files unless configured to do so.

**When Virex was scanning a file, I dragged & dropped another file to be scanned. What happened to the file?**
During a scan, you cannot add files to the scanning queue. Dragging multiple items simultaneously queues the scan; that is, dragging and dropping three folders or files would cause the scanner to perform three scans. Dragging one folder containing multiple files causes the scanner to perform one scan.

**Why is Virex not scanning my computer at regular intervals?**
Check that you have an on-demand scan schedule set up to scan your computer, it is enabled, and it is configured to run regularly.

**What are the advantages of turning on the Background Scanner?**
The Background Scanner constantly scans your system for infected files. It is a low-resource process that increases your protection against viruses without affecting the performance of your computer.

Viruses and detection

**Can Virex detect both Macintosh and Windows viruses?**
Virex detects all known Macintosh and Windows viruses and worms.

**Why is the Mounted Volumes Scanner not working?**
Ensure that you enable the **Scan local volumes when mounted** in the Preferences dialog box.

**Why has Virex stopped displaying items that are scanned?**
Virex will only show the first 200,000 items that are scanned.
Why is the content in my log file cut off?
The size of a log file cannot exceed 120kb. When a log file does exceed 120kb, the file is reduced to 100kb. If you specifically want to keep a copy of the existing log file, we recommend that you save old log files before starting a new scan. To view the log file, select View Log under File on the main menu.

General information

Can I undo the changes I made to the Preference settings?
If you have saved unwanted preferences, the settings can be reset to their default by clicking Reset to Defaults on the lower left corner of the Preferences window. There is no way to undo preference setting changes once they are made; settings in the Preferences menu are saved as soon as any change is made. We recommend that you make a note of your current preference settings before changing them.

Is there rollback support with eUpdate?
eUpdate only supports current or new updates. There is no rollback support.

When I close the Virex program, is it still running in the background, or is the program shut down?
Once installed all scanners are loaded and running in the background. The Active Scanner is on by default, but the Background and Mounted Volumes Scanners are off unless turned on in Preferences.

Are Macintosh virus definitions included in the updates?
The eUpdates include both Macintosh and Windows virus definitions.

How do I find out the version number and date of the virus definitions (DAT files)?
Select About Virex from the Virex 7.6 menu on the menu bar of the Virex 7.6 application. The dates of the DAT versions only reflect when the DAT files were created.

How often are DAT files updated automatically in Virex?
eUpdate checks for new updates on its own every week via the Internet. Virex 7.6 does not offer daily updates. You can manually download daily updates from the McAfee Virus Information Library web site.

Why can’t I connect to the eUpdate Server to perform an unscheduled eUpdate?
Check to see if you are connected to the Internet. The eUpdate server may also be busy.
Advanced troubleshooting

After installing Virex, can I view the processes running?
In Mac OS 10.3.X Panther, use the Activity Monitor to view processes. In Mac OS 10.2.X Jaguar, use the Process Viewer. The running processes are VShield (Active Scanner), VShieldBKgd (Background Scanner), VShieldCore (Core Scanner), VShieldCheck (Health Check), VShieldMount (Mounted Volumes Scanner), and VShieldUpdate (eUpdate).

How do I configure Virex to scan ONLY when and what I want it to?
Click on Preferences in the Virex Console. Deselect the checkbox beside Scan local volumes when mounted, Background virus detection, and Active virus detection.

Disabling Virex leaves your computer vulnerable to viruses. Scanner preferences are global settings that apply to all users setup on your computer.

Can I manually download virus definitions without using eUpdate?
On the Tool bar of the Virex Console, click the Virus Info button. This launches your default browser and directs you to the McAfee Virus Information Library. Click on Downloads on the left hand side of the screen to download DAT files.

How do I customize eUpdate Server Settings?
If you need information about how to change your eUpdate Server Settings, call Customer Service toll free at +1-888-847-8766 (US, Canada, and Latin America).

Where can I find the log files?
The following is a list of log files.

<table>
<thead>
<tr>
<th>Log file</th>
<th>Description</th>
<th>Where can I find them</th>
</tr>
</thead>
<tbody>
<tr>
<td>virex.log</td>
<td>This log file contains Virex related entries. You can also access this log file from the Virex Help menu.</td>
<td>/var/log/virex.log</td>
</tr>
<tr>
<td>VirexEPOLog.log</td>
<td>This log file contains entries made by VShieldEpolnterface daemon that communicates between ePolicy Orchestrator Agent and Virex.</td>
<td>/var/log/VirexEPOLog.log</td>
</tr>
<tr>
<td>log</td>
<td>This log file contains ePolicy Orchestrator Agent related entries.</td>
<td>/Library/NETAepoagt/scratch/etc/log</td>
</tr>
</tbody>
</table>
Error messages - Virex application

The following is a list of possible error messages you can see while running Virex application and the possible reasons for their occurrence.

Table 4-2 Error messages - Virex application

<table>
<thead>
<tr>
<th>Serial No.</th>
<th>Message</th>
<th>Possible Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Virex Application can not be launched because the Health Check component is not responding. Please restart or re-install.</td>
<td>If you just installed Virex, you need to restart your computer to allow the daemons to load. If you have not just installed Virex, the Health Check daemon may have become corrupt and requires that you re-install.</td>
</tr>
<tr>
<td>2</td>
<td>Initialization of virex engine failed (error x).</td>
<td>The engine or DAT files have become corrupted or have been moved/deleted. Please re-install.</td>
</tr>
<tr>
<td>3</td>
<td>The Report could not be saved. Maybe the disk is full or there is no data to be written.</td>
<td>Your disk may not have enough space to save the report. Free up some room and try to save again.</td>
</tr>
<tr>
<td>4</td>
<td>The URL for the Virus Information Library could not be opened.</td>
<td>Please ensure that your browser is installed correctly.</td>
</tr>
<tr>
<td>5</td>
<td>An error occurred while installing the update. The eUpdate was not completed.</td>
<td>There was an error when attempting to install the update. Please restart the eUpdate process and try again.</td>
</tr>
<tr>
<td>6</td>
<td>An error occurred while unpacking the update. The eUpdate was not completed.</td>
<td>There was an error when attempting to unpack the update for installation. Please restart the eUpdate process and try again.</td>
</tr>
<tr>
<td>7</td>
<td>An error occurred while downloading the update. The eUpdate was not completed.</td>
<td>There was an error when attempting to download the update. The server may be currently busy. Wait a few minutes then restart the eUpdate process and try again.</td>
</tr>
<tr>
<td>8</td>
<td>This software product is becoming close to the end of its designed life. To maintain correct anti-virus capability, it is recommended that the product is updated as soon as possible.</td>
<td>Your version of Virex has become outdated. It is recommended that you upgrade to the newest version of Virex to ensure the best virus protection possible.</td>
</tr>
<tr>
<td>9</td>
<td>This software product is coming very close to the end of its designed life and its further use can no longer be supported. To maintain correct anti-virus capability, it is now important that the product is updated as soon as possible.</td>
<td>Your version of Virex has become outdated. It is recommended that you upgrade to the newest version of Virex to ensure the best virus protection possible.</td>
</tr>
</tbody>
</table>
Table 4-2  Error messages - Virex application

<table>
<thead>
<tr>
<th>Serial No.</th>
<th>Message</th>
<th>Possible Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>This software product can no longer provide satisfactory virus protection. To maintain correct anti-virus capability, it is now necessary that the product is updated.</td>
<td>Your version of Virex has become outdated. It is strongly recommended that you upgrade to the newest version of Virex to ensure the best virus protection possible.</td>
</tr>
<tr>
<td>11</td>
<td>The scanning engine installed for this product is coming close to the end of its designed life. To maintain correct anti-virus capability, it is recommended that the scanning engine is updated as soon as possible.</td>
<td>The engine included with Virex has become outdated. It is recommended that you eUpdate as soon as possible to ensure the best virus protection possible.</td>
</tr>
<tr>
<td>12</td>
<td>The scanning engine installed for this product is coming very close to the end of its designed life and its further use can no longer be supported. To maintain correct anti-virus capability, it is now important that the scanning engine is updated as soon as possible.</td>
<td>The engine included with Virex has become outdated. It is recommended that you eUpdate as soon as possible to ensure the best virus protection possible.</td>
</tr>
<tr>
<td>13</td>
<td>The scanning engine installed for this product can no longer provide satisfactory virus protection. To provide correct anti-virus capability, it is now necessary to update the scanning engine.</td>
<td>The engine included with Virex has become outdated. It is strongly recommended that you eUpdate as soon as possible to ensure the best virus protection possible.</td>
</tr>
</tbody>
</table>

Error messages - virex.log

The following is a list of possible error messages you can see in the virex.log and the possible reasons for their occurrence.

Table 4-3  Error Messages - virex.log

<table>
<thead>
<tr>
<th>Error No.</th>
<th>Message</th>
<th>Possible Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>VShieldCore reports: [ActiveScanner] AV Engine reports object /Library/Caches/com.apple.LaunchServices.LocalCache.csstore~(accessed by process 449) could not be scanned due to error 2.</td>
<td>Virex 7.6 is denied access to the file by the Mac OS X operating system, possibly because the file is being modified or is in use by another application. Try quitting the open applications before you rerun the scan.</td>
</tr>
<tr>
<td>10</td>
<td>VShieldCore reports: [ActiveScanner] AV Engine reports object /dev/null [accessed by process 438] could not be scanned due to error 10.</td>
<td>A special file can be critical files or objects of the Mac OS system. Quitting applications and rescanning does not scan such items. It is expected behavior that Virex 7.6 reports such errors.</td>
</tr>
</tbody>
</table>
Glossary

**Active Scanner**
A feature of Virex that scans files when they are written to your hard drive. It starts when your computer starts and runs until the computer is shut down.

**Background Scanner**
A Virex feature that continually scans all the files on your computer.

**Core Scanner**
This scanner provides queuing for scan tasks and powerful scanning tools to operate the individual scanners.

**Daemon**
A program that runs constantly and exists to handle service requests the computer system receives. The daemon program then forwards these requests to other programs or processes.

**DAT files**
Virus definition files that allow the anti-virus software to recognize viruses and related potentially unwanted code embedded in files.

**DMG files**
DMG files are self-mounting disk images.

**EICAR**
European Institute of Computer Anti-Virus Research. They have developed a string of characters that can be used to test the proper installation and operation of anti-virus software.

**eUpdate**
eUpdate allow you to update your DAT files and the virus-scanning engine. It automatically checks weekly for new updates when there is an Internet connection.

**Extra DAT files**
Supplemental virus definition file that is created in response to an outbreak of a new virus or a new variant of an existing virus.

**Firewall**
A program that acts as a filter between your computer and the network or Internet. It can scan all traffic arriving at your computer (incoming traffic) and all traffic sent by your computer (outgoing traffic). It scans traffic at the packet level, and either blocks it or allows it, based on rules that you set up.

**FTP**
File Transfer Protocol. It is a common way to move files between two Internet sites.
Global Administrator
A user account with read, write, and delete permissions, and rights to all operations. Operations that affect the entire installation are reserved for use only by global administrator user accounts.

HealthCheck
HealthCheck is a Virex feature that keeps track of current preferences and the exclusion list and continues them when restarting a scanner. If any of the components quit, HealthCheck restarts the scanner automatically.

HTTP
HyperText Transfer Protocol. It is a protocol for moving files across the Internet. It requires an HTTP client program on one end and an HTTP server program on the other.

Incremental DAT files
New virus definitions that supplement the virus definitions currently installed. Allows the update utility to download only the newest DAT files rather than the entire DAT file set.

Joke program
A non-replicating program that may alarm or annoy an end user, but does not do any actual harm to files or data.

Log
A record of the activities of a component of McAfee anti-virus software. Log files record the actions taken during an installation or during the scanning or updating tasks.

Macro
In some programs like word-processing programs, a macro is a saved sequence of commands that can be stored and then recalled with a single command or keyboard stroke.

Mounted Volumes
Mounted drives are sometimes considered mounted volumes. An example of a mounting process is when one inserts a CD into a drive. In this case, a volume (CD) gets mounted on the desktop.

Mounted Volumes Scanner
This scanner initiates a scan of a volume such as a CD or camera when you mount it to your system. This feature is only available with locally inserted or ejectable media, such as Zip drives, CD, DVD, or OS X.

McAfee Virus Information Library
This web site (http://vil.nai.com/vil/default.asp) has detailed information about the origins of viruses, how they infect your computer, and how to remove them. The site also discusses e-mail hoaxes.

On-Demand Scanner
The On-Demand Scanner allows you to initiate a scan at any time by dragging and dropping selected files into the console or through a file open dialog box. You can scan multiple files, directories, and volumes.

Trojan horse
A program that either pretends to have, or is described as having, a set of useful or desirable features, but actually contains a damaging payload. Trojan horses are not technically viruses, because they do not replicate.

UTC time
Coordinated Universal Time (UTC). This refers to time on the zero or Greenwich meridian.

Uvscan Command-line Scanner
This scanner allows advanced scanners to access the on-demand scanner from the terminal shell.

Virex Console
This is the most common user interface for Virex. This console allows you to schedule tasks, configure the scanners, and start eUpdates.
**Virex Schedule Editor**
This Virex feature allows you to schedule additional virus definition and software updates.

**Virex Reporter**
The Reporter shows you the results of the anti-viral scanning in the form of reports.

**Virus**
A program that is capable of replicating with little or no user intervention, and the replicated program(s) also replicate further.

**Worm**
A virus that spreads by creating duplicates of itself on other drives, systems, or networks. It does not attach itself to additional programs but can alter, install, or destroy files and programs.
Index

A
active scanner, 9
  configuring, 27
active virus detection, 28
advanced global preferences, 28
audience for this manual, 11
automatically check for virus definition updates, 28
AVERT
  Anti-Virus & Vulnerability Emergency Response Team, contacting, 16
  DAT notification service, 16
  WebImmune, 16

B
background scanner, 9
  configuring, 27
background virus detection, 28
beta program, contacting, 16

C
clear report, 26
command-line scanner, 10
configuration guide, 13
  configuring
    active scanner, 27
    background scanner, 27
    mounted volume scanner, 27
    on-demand scanner, 27
console, 25
consulting services, 17
contacting McAfee, 16
core scanner, 10
customer service, contacting, 17

D
DAT file
  updates via AVERT notification service, 16
  updates, web site, 17
definition of terms (See Glossary)
delete virus, 28
documentation for the product, 13
download web site, 17
eUpdate, 11
task dialog box, 34
exclusion list, 28
creating, 29

E
EICAR, 22
erreur messages
  virex application, 41
  virex.log, 42
eUpdate, 11
  task dialog box, 34
  exclusion list, 28
  creating, 29
features, 7
general troubleshooting information, 39
  getting information, 13
  list of contacts, 16
  within the product, 14
glossary, 43
HealthCheck, 10
installation
  testing, 22
  troubleshooting, 37
  upgrade installation, 21
  installing software, 20
joke programs, finding, 28

L
links to resources in the product, 14
log file, 40
  log, 40
virex.log, 40
VirexEPOLog.log, 40
log results to file, 28

M
manuals, 13
McAfee University, contacting, 17
McAfee Virus Information Library, 26
menu bar, 27
mounted volume scanner, 9
  configuring, 27
new features, 7
non windows agent readme, 13
notification service, DAT updates, 16
notify of virus, 28
on-demand scanner, 10
  configuring, 27
  using, 30
on-site training, 17
preferences
  advanced global, 28
  advanced scanner, 28
  configuring, 26
  dialog box, 27
PrimeSupport, 16
print report, 26
product documentation, 13
product information, resources, 13
product overview, 5
product training, in-house, 17
reccurrence, scheduling, 33
removing macros, 28
report
Virex® 7.6 Product Guide

Index

clearing, 26
printing, 26
saving, 26
reporting window, 30
resources for information, 13

S
save report, 26
scan local volumes when mounted, 28
scan task dialog box, 32
scanner advanced preferences, 28
scanning
archives, 28
compressed files, 28
troubleshooting, 38
schedule editor, 11
using, 31
scheduling
eUpdates, 33
scans, 31
security headquarters, contacting AVERT, 16 to 17
server settings, 28
service portal, PrimeSupport, 16
setting preferences, 26
submitting a sample virus, 16
system requirements, 19

T
technical support, 40
contact information, 16
testing your installation, 22
title bar, 26
tool bar, 26
training web site, 17
training, on-site, 17

U
uninstalling Virex, 22
updating, 11, 33
upgrade web site, 17
using this guide

typeface conventions and symbols, 12
uvscan command-line scanner, 10

V
Virex software, 5
installing, 20
requirements, 19
testing, 22
uninstalling, 22
VirexReporter, 11

using, 35
Virus Information Library, 15 to 16, 26
virus, submitting a sample
web site, 16
virus-like characteristics, 28

W
WebImmune, 16
what's new in this release, 7